XenData S3 Server Interface
Requesting and Installing
an SSL Certificate
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Note: Local Administrators is the minimum group membership required to complete these
procedures.

1. Creating a Certificate Signing Request (CSR)

If you are ordering your SSL certificate from DigiCert, you can skip steps 1.1 through 1.22 and
instead, follow the instructions found here: https://www.digicert.com/kb/util/csr-creation-
microsoft-servers-using-digicert-utility.htm

The following instructions will generate a Certificate Signing Request, they should be followed
on the server that the SSL certificate will be installed on. The CSR can be submitted when
requesting an SSL certificate, the Certificate Authority will create an SSL certificate based on
the CSR. If an SSL certificate has already been requested and created, the same CSR can be
used to request a ‘re-key’, whereupon the Certificate Authority will provide a new SSL
certificate based on the CSR.

1.1 Right-Click Start, select Run
1.2 Type MMC in the Run box and press Enter
1.3 Click on the Files menu, then click Add/Remove Snap-in

1.4 From the available snap-ins list, click Certificates then click Add

=
@ File Action
&= o =

_| Console Root

Vi

Add or Remove Snap-ins

X

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For extensible
snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:

Snap-in Vendor | [] Console Root Edit Extensions...
- ActiveX Control Microsoft Corp... -
[T Authorization Manager  Microsoft Corp... SRk
@l Microsoft Corp...

. Component Services  Microsoft Corp... Move Up
gu-' Computer Managem... Microsoft Corp...

A Device Manager Microsoft Corp... Move Dowr
== Disk Management Microsoft and ... Add >

Event Viewer Microsoft Corp...

| Folder Microsoft Corp...

\=[ Group Policy Object ... Microsoft Corp...
-g, IP Security Monitor Microsoft Corp...
E, IP Security Policy Ma...  Microsoft Corp...
] Link to Web Address Microsoft Corp...
14 Local Backup Microsoft Corp... Advanced...
B i nrslllcare and Mirraenft Carn

Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

e



https://www.digicert.com/kb/util/csr-creation-microsoft-servers-using-digicert-utility.htm
https://www.digicert.com/kb/util/csr-creation-microsoft-servers-using-digicert-utility.htm

1.5 Select Computer account, then click Next

Certificates snap-in

This snap-in will always manage certificates for:

() My user account

() Service account

@/Computer account]

1.6 Select Local computer and click Finish

Select Computer

Select the computer you want this snap-in to manage.

This snap-in will always manage:

@® |Local computer. (the computer this console is running on) |

() Another computer: Browse...

["] Allow the selected computer to be changed when launching from the command line. This
only applies if you save the console.




1.7 On the Add or Remove Snap-ins dialog, click on OK

Add or Remove Snap-ins

Available snap-ins:

Snap-in Vendor

= ActiveX Control Microsoft Corp...
Audwrizaﬁon Manager Microsoft Corp...
' Microsoft Corp...
. Component Services Microsoft Corp...
.'g Computer Managem... Microsoft Corp...
ﬁ Device Manager Microsoft Corp...
u Disk Management Microsoft and ...
{3] Event Viewer Microsoft Corp...
[| Folder Microsoft Corp...
\=[ Group Policy Object ...  Microsoft Corp...
8, 1P Security Monitor Microsoft Corp...
&, 1P Security Policy Ma...  Microsoft Corp...
| Link to Web Address Microsoft Corp...
4 Local Backup Microsoft Corp...
Bt ~rslllcare and Cra Mirrnenft Carn

Description:

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For extensible
snap-ins, you can configure which extensions are enabled.

Selected snap-ins:
[ Console Root Edit Extensions...
[l Certificates (Local Computer)

Remove
Move Up

Move Down

Add >
Advanced

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

X

Cancel

1.8 Under the Console Root folder, expand Certificates (Local computer)
1.9 Right-click the Personal folder and select: All Tasks, then Advanced Options, and click

Create Custom Request

ﬁ Console1 - [Console Root\Certificates (Local Computer)\Personal] — O X
% File Action View Favorites Window Help - 8 X
&% 2E 8| 6=
[ Console Root Object Type Actions
v Eﬁ] Certificates (Local Computer) [ Certificates Personal o~
> ] Perscral ——
[ Trust Find Certificates.. More Actions 4
= Ent
:‘ neel All Tasks Find Certificates.
| Inten
;1 Trust, View Request New Certificate...
&1 Untn New Window from Here Import...
| Third
[ Trust New Taskpad View... Advanced Operations > Create Custom Request..
= ai ici
:_1 'E"" Refresh Manage Enrollment Policies...
|| Previ
Export List..
-] Othe Help

[T
[ MSIEHistoryJournal

[ Remote Desktop

[ Certificate Enrollment Requests
1 s3archivel.xendata.com

| Smart Card Trusted Roots

[ Trusted Devices

| Windows Live ID Token Issuer

>
>
>
>
>
>
>
>
>
> [ Testt
>
>
>
>
>
>
>
>
>
> [] WindowsServerUpdateServices

&Create Custom Request..




1.10 On the Certificate Enrollment dialog, read Before you begin, click on Next

1.11 On the Select Certificate Enrollment Policy dialog, select Proceed without enroliment
policy, click on Next

5 Certificate Enrollment

Select Certificate Enrollment Policy

Certificate enrollment policy enables enrollment for certificates based on predefined certificate terplates
Certificate enrollment policy may already be configured for you.

Configured by you Add New
Custom Request

Proceed without enrollment pelicy

1.12 On the Custom Request dialog, leave the default values, then click Next

- O b
=5 Certificate Enroliment

Custom request

Chose an option from the list below and configure the certificate options as required.

Template: (Mo template) CNG key

[]Suppress default extensions

Request format: (@) PKCS #10
[@]ele

Mote: Key archival is not available for certificates based on a custem certificate request, even when this
option is specified in the certificate template,

Cancel



1.13 Expand the details pane and select Properties

5] Certificate Enrollrent

Certificate Information

Click Mext to use the options already selected for this template, or click Details to customize the certificate
request, and then click Mext.

e —
Custem request J‘J STATUS: Available Details &
The following options describe the uses and validity period that apply to this type of certificate

Key usage:
Application pelicies:
Validity peried (days):

I Mext || Cancel |

1.14 Add a Friendly name and description for the certificate, then select the Subject tab

Certificate Properties bt

General Subject Extensions Private Key
A friendly name and description will make it easier to identify and use a certificate.

Friendly name:

| s3archivel.xendata.com |

Description:

| XenData Archive Server |

oK || Cancel || Apply |




1.15 Move to the Subject tab, and add certificate details, the ones we used were Common
Name, Organization, Organization Unit, Location, County

Certificate Properties

X

General Subject Extensions Private Key

The subject of a certificate is the user or computer to which the certificate is issued. You

can enter information about the types of subject name and alternative name values that
can be used in a certificate.

Subject of certificate
The user or computer that is receiving the certificate
Subject name:
Type: CN=s3archive1.xendata.com
O=XenData Inc
Add >
Country OU=Engineering

Value: L=Walnut Creek
< Remove S=California

C=USA

Alternative name:

Type:
s3archive1.xendata.com
DNS

Value:

Add >

< Remove

0K Cancel Apply

1.16 Move to the Extensions tab, expand ‘Extended Key Usage’ and add Server
Authentication, and Client Authentication

Certificate Properties

General Subject Bxtensions  Private Key

The following are the certificate extensions for this certificate type.

Key usage

Extended Key Usage (application policies) A

An application policy (called enhanced key usage in Windows 2000) defines how a
certificate can be used. Select the application policy required for valid signatures of
certificates issued by this template.

Available options: Selected options:

Server Authentication
Secure Email

Time Stamping
Microsoft Trust List Signil Add >
Microsoft Time Stampinc
IP security end system

IP security tunnel termin:
IP security user

Encrvotina File Svstem
< > <

Client Authentication

< Remove

[] Make the Extended Key Usage critical

Basic constraints

OK Cancel Apply




1.17 Move to the Private Key tab and expand ‘Cryptographic Service Provider’. Ensure that
only RSA Microsoft Software Key Storage Provider is checked

Certificate Properties x
General Subject Extensions Private Key
Cryptographic Service Provider .
A C5Pis a program that generates a public and private key pair used in many
certificate-related processes,
Select cryptographic service provider (CSP):
RS54, Microsoft Software Key Storage Provider ~
[] DH,Microsoft Software Key Storage Provider
[ DS&, Microsoft Software Key Storage Provider
[]ECDH,Microsoft Software Key Storage Provider
[]ECDH_brainpoolP180r1, Microsoft Software Key Storage Provider
[]ECDH_brainpoolP180t1, Microsoft Software Key Storage Provider o
[ Show all C5Ps
Key pptions hd
Select Hash Algorithm hd
Select Signature Format ¥ v
Concel | [ porty

1.18 Expand ‘Key Options’ and change the Key Size to 2048, and check ‘Make Private Key
Exportable’

Certificate Properties X

General Subject Extensions Private Key

Select cryptographic service provider (CSP):

RS54, Microsoft Software Key Storage Provider ~
[ DH,Microsoft Software Key Storage Provider

[ DSA,Microseft Software Key Storage Provider

[] ECDH,Microsoft Software Key Storage Provider

[ ECDH_brainpoolP160r1, Microsoft Software Key Storage Provider
[]ECDH_brainpoolP160t1,Microsoft Software Key Storage Provider

[ Show all C5Ps

Key options A
Set the key length and expert options for the private key.

Key size: | Hpag o

[] Make private key expaortable
[J Allow private key to be archived

[] 5trong private key protection

Cancel Aoply




1.19 Apply all these settings and click OK
1.20 On the Certificate Information dialog, click Next

|$| Certificate Enrollment

Certificate Information

Click Next to use the options already selected for this template, or click Details to customize the certificate
request, and then click Next.

Custom request 1) STATUS: Available Details
The following options describe the uses and validity period that apply to this type of certificate:
Key usage:

Application policies: Server Authentication
Client Authentication

Validity period (days):

o

1.21 Save the file in Base 64 file format with a .txt extension and select Finish

5] Certificate Enrollment

Where do you want to save the offline request?

If you want to save a copy of your certificate request or want to process the request later, save the request to
your hard disk or removable media. Enter the location and name of your certificate request, and then dick
Finish.

File Name:

sBarchive1—requesﬂ Browse..

File format:
(@) Base 64

() Binary

coce




1.22 Open the saved file, select all and copy, this is the CSR which can be used when
requesting an SSL certificate from the Certificate Authority

| s3archive1-request.txt - Notepad - O X
q p
File Edit Format View Help

MIIET]jCCAZYCAQAWEYCcXDDAKBENVBAYTALVTQTETMBEGALIUECAWKQ2F salWZvemsp
TEVMBMGA1UEBwWwWMV2FsbnVOIENYZWVrMRQwWEEYDVQQLDAtFbmdpbmV1lcmluZzEU
MBIGA1UECEWLWGVURGF@YSBIbmMxHzAdBENVBAMMFNMzYXJjaGl2ZTEUeGVUZGF@
S5jb20wggEiMABGCSqGSIb3DQEBAQUAAAIBDWAWEEEKAOIBAQCUaWqZGK3B0o26P
78nYztwgckYZ9RpS1IUwHpD5tIafm2oWuSZmKewE9suUhVKeItBijxyYnSJu+ylx
t3+pvVkwqO2fX5aPFuMDBXaAYgXM2QRA1DfgUp7qiqrz/ble/5b2s+NbYOKdPCy /
Lox@tZZUVUkxKvFVNY1vBmeDwIMWOF /g0gZ50EYkgLTepgLWN®71mXsqoEtFLCIW
SalFfMjzA6s71IbyALrHVIbIVWYTECpn+/fT61181aqt TmbTTMIEZDYY2KUhI8XZ
LsH1DHc7cKVHM1ZSWZL7SjuxM616Z5MQBQqyUk7Zwm7EZzsIrvAAXhPYETMT16GZT
rtezDz19AgMBAAGEEEF /MBWGCisGAQQBgjcNAgMXDhYMMTAUMCAXNZc2My4yMDeG
CSsGAQQBgjcVFDEWMCACAQUMCFg@MFR1cmIvDBZYNDBUVVICT1xBZG1lpbmlzdHIh
dda7CLm44Ts31mOIobrS/nyq50hdcyt2Dwd4PUwPfnvmhFWErYaqiiCBoxKtZgh3,
bwBmAHQAIABSAFMAQQAEAFMAQWBOAGEAbEBUAGUADAAEAEMACEBSAHAAJABVAGCA]
cgBhAHAAaABPAGMATABQAHTAbWB2AGKAZAB1AHIDAQAWEaSGCSqGSTb3DQEIDIGB)
nTCBmjAhBgNVHREEGjAYghZzM2FyY2hpdmUxLnhlbmRhdGEUY29tMBOGA1UdIQQMW
MBQGCCSGAQUFBWMBBggrBgEFBQcDAjANBgkrBgEEAYI3FQoEGjAYMAOGCCSGAQUF
BWMBMAOGCCsGAQUF BWMCMB@GA1UdDEQWBBQHYWD7BaHBhjrS /SAHQXFLpQ26H]AQ)
BgNVHQ8BATSEBAMCBSAWDQYJKoZIhvcNAQEFBQADggEBAISrn+3SQQCdItzeNfZc
dda7CLm44Ts31mOIobrS/nyq50hdcyt2Dwd4PUwPfnvmhFWErYaqiiCBoxKtZgh3,
gQ8BXVMhYrvivirZtplS8Txaveede/jsHTVOghhfaYjIGShvVhTNIoNPPdai9/EX
jKcrpexIiXUubXel+29pMY3811sh9DeD/28X7eY1GI2j39RzZBTkEjv5aSks7D/
dda7CLm44Ts31mOIobrS/nyq50hdcyt2Dwd4PUwPfnvmhFWErYaqiiCBoxKtZgh3,
FhPJIfEtd117+bnoYGyCUJvwm3W8+Sm2MkxZk09rhP3I8XnFHB+Bc3+I01dItMQN/

--END NEW CERTIFICATE REQUEST-----

Windows (CRLF) Ln 1, Col 1 100%

1.23 Download your SSL certificate. If prompted for Server type, choose “1IS” and download
the Zip file. After saving the Zip file, copy it to the server and extract it to a known
location



2. Submitting a Re-Key Request for an Existing SSL Cert

If an SSL certificate has already been purchased, the CSR can be used to request a re-key for the
server on which you want to install the certificate. The following instructions describe the
process used to re-key a certificate where the Certificate Authority is GoDaddy; equivalent
functionality should be found on the websites of other Certificate Authorities.

2.1 Navigate to the SSL Cert management console
2.2 Paste the CSR content into the SSL certificate providers SSL Certificate Signing Request
(CSR) tool and click ‘Add Change’

© YA New Keys
Certificate Signing Request (CSR)

= " Rekey your certificate if you lost
“““ END NEW your private key or moved your
CERTIFICATE REQUEST---- website a new server. Learn more
, f
Problem with your CSR? Try SSL You can generate a Certificate
Tools Signing Request (CSR) from your

server by using the server's

software. Your CSR contains a
Add Change

public key that matches the

private key generated at the
same time.

2.3 Submit the certificate request (response times vary from a few minutes to a week or
more, depending on the certificate type)

If domain ownership verification is required for these changes, you may
choose how you would like to prove you have control of the domain(s).

Domain Control Options

Cancel Submit All Changes




2.4 Your Certificate Authority should email you once the certificate is ready

24/7 Support: +1 (480) 463-8887
(),GoDaddy

The SSL for s3archivel.xendata.com
has been issued.

Congrats, The Standard SSL Certificale is ready to install
1. Sig y and download the certificate

2 to install it on your hosting account or server

2.5 Download your SSL certificate. If prompted for Server type, choose “1IS” and download
the Zip file. After saving the Zip file, copy it to the server and extract it to a known

location
Certificate Details Download Certificate
To secure your site that's hosted elsewhere,
Type Standard SSL Certificate download the Zip file that matches your
hosting server type. Then, install all of the
certificates in the Zip file on your hosting
Status Certificate issued (Revoke) . . . .
server, including any intermediate certificates
that might be needed for older browsers or
Domain name s3archivel.xendata.com servers.
First time installing a certificate?
Certificate |ssuer GoDaddy SHA-2 View Installation Instructions for the selected
server.
Request Date 7/12/202110:13

Server type

Request Submission Type Rekey s 5 Download Zip File

Current Certificate Validity Period 7/12/2021 - 4/8/2022
Subscription Period 4/8/2021 - 4/8/2022

Serial Number c6:25:f2:1:b3:9a:26:17



3. Installing the Certificate on the Server

3.1 Right-
3.2 Type MMC in the Run box and press Enter

3.3 Click on the ‘Files’ menu, then click ‘Add/Remove Snap-in’

Click Start, select Run

3.4 From the available snap-ins list, click ‘Certificates’ then click Add

‘(‘ sole1 - [Col
File  Action
&% [ =

| Console Root

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

nsole Root] X
Vi Add or Remove Snap-ins X -|2|x

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For extensible

snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins: —
Snap-in Vendor ~ ["] Console Root Edit Extensions... 4
=" ActiveX Control Microsoft Corp...

[E3Authorization Manager  Microsoft Corp... s
&1 Certificates | Microsoft Corp...
. Component Services  Microsoft Corp... e U
3 Computer Managem... Microsoft Corp...
% Device Manager Microsoft Corp... Move Down
= Disk Management Microsoft and ... Add >
{3] Event Viewer Microsoft Corp...
_| Folder Microsoft Corp...
\=/ Group Policy Object ... Microsoft Corp...
‘g IP Security Monitor Microsoft Corp...
8, 1P Security Policy Ma...  Microsoft Corp...
|| Link to Web Address Microsoft Corp...
14 Local Backup Microsoft Corp... Acvanced..
B | nrsllleare and Cen Mirrnenft Carn
Description:

3.5 Select ‘Computer account’, then click ‘Next’



Certificates snap-in

This snap-in will always manage certificates for:
() My user account

() Service account

© [Computer account]

Cancel

3.6 Select ‘Local computer’ and click Finish

Select Computer

Select the computer you want this snap-in to manage.
This snap-in will always manage:

@&ocal computer: (the computer this console is running on) |

() Another computer:

[] Allow the selected computer to be changed when launching from the command line. This

only applies if you save the console.

Finish




Then select ‘OK’ to return to the MMC, where you will see the screen shown in section 3.7

below

3.7 Under the ‘Certificates (Local Computer)’ select ‘Personal’, then right-click and select ‘All
Tasks’, then select ‘Import’

|G File Action

&= 2 F 0

View

Gz HE

Favorites Window Help

Console1 - [Console Root\Certificates (Local Computer)\Personal]

] Console Root

> | Persor
> [ Truste
> [ Enterf
> [ Intermr
> [ Truste
Untru:
Third-
Truste
Client
Previe
Test R
Other

[

2 0 2 I

v @ Certificates (Local Computer)

Find Certificates...
All Tasks

View

New Window from Here
New Taskpad View...

Refresh
Export List...

Help

Local hunremovauie Ceruncates
MSIEHistoryJournal

Remote Desktop

Certificate Enrollment Requests
[ s3archivel.xendata.com

~ || Object Type
" Certificates

Find Certificates..

Request New Certificate...
Import...

Advanced Operations

|Add a certificate to a store

3.8 Click Next on the Welcome to the Certificate Import Wizard dialog




=% Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trustlists, and certificate revocation
ligts from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

Store Location
Current User

Local Machine

To continue, dick Next.

Canca

3.9 Browse to the location you extracted the SSL certs ZIP file and select the .CRT file and click
‘Next’



€ L# Certificate Import Wizard

File to Import
Specify the file you want to import.

File name:

Note: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P7B)

Microsoft Serialized Certificate Store (.SST)

cancl

3.10 Choose to place all certificates into the Personal Certificate store and click ‘Next’



& &+ Certificate Import Wizard

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

(O Automatically select the certificate store based on the type of certificate

®|Place all certificates in the following store |
Certificate store:

Personal Browse...

3.11 Click on ‘Finish’



& L* Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you click Finish.

You have specified the following settings:

Certificate Store Selected by User RS Euc
Content Certificate
File Name C:\Users\Administrator\Documents\s3archive1.xendat
< >
=
Certificate Import Wizard X

o The import was successful.

OK

3.12 Repeat steps 3.9 through 3.11 for the .P7B file

3.13 After importing the CRT and P7B files, the certificate should be visible in the Personal
Certificate store



% Consolel - [Console Root' Certificates (Local Computer)\Personalt Certificates] — O =
ﬁ File  Action View Favorites Window Help - 8 X
L 2] N =RNNEN 7)o
[ Console Root ™| lssued To Issued By Expiration Date  Intended Purposes F|| Actions

v & cf"t;"ate‘ I(L"‘a' Computer) || (=166 Daddy Root Certificate Auth... Go Daddy Class 2 Certification Au... 5/29/2031 <All> <|| Certificates -

~ || Persona g -
[ Certificates %Go Dat.idy Secure Certificate Au... Go Daddy Root Certlf\.c.ate Author...  5/2/2031 <All> o < More Actions
» [ Trusted Root Cerfification Es3archivel.xendata.com Go Daddy Secure Certificate Auth...  8/4/2022 Server Authenticati.. s
> [ Enterprise Trust
> [ Intermediate Certification
5 || Trusted Publishers
5 || Untrusted Certificates w
£ > £ >

Personal store contains 3 certificates.

3.14 Double click on the imported certificate and ensure that below the ‘Valid from date’,
there is a small key and the words ‘You have a private key that corresponds to this
certificate’.

M Certificate X

General Detals Certification Path

A Certificate Information

This certificate is intended for the following purpose(s):

* Proves your identity to a remote computer
* Ensures the identity of a remote computer
©2.16.840.1.114413.1.7.23.1
©2.23.140.1.2.1

* Refer to the certification authority’s statement for details.

Issued to: *.cambridge.xendata.com
Issued by: Go Daddy Secure Certificate Authority - G2

Valid from 11/04/2025 to 13/05/2026
¥ You have a private key that corresponds to this certificate,

Issuer Statement

3.15 Now open the Details tab. Scroll to the bottom and then select and copy the contents
of the “‘Thumbprint’ field



a  Certificate K

General Details Certification Path

Show: | <all> ~
Field Value A
&3 Authority Key Identifier KeyID=40c2bd278ecc348330...
@_1_| Subject Alternative Name DNS Name=s3archive 1.xenda. ..
l_;_ﬂ Subject Key Identifier 076160fb05a1c1863ad2fd2e0. ..
{3 /scT List v1, 2979bef09e393921f05673...
i | Basic Constraints Subject Type =End Entity, Pat. ..
_l ,__|Key Usage Digital Signature, Key Endpher...
|| Thumbprint f558c8b0f6fbSbbf143f37252. ..
W

£558c8b0feffbSbbf143£372524829b2ddaBal59

Edit Pr

(=]

=

erties... Copy to File...

T

3.16 Open a PowerShell session with the “Run as Administrator” option
3.17 Generate a GUID using the following command:

[guid]::NewGuid() .ToString("B")

3.18 To add the SSL cert to the S3 DNS name, enter the following netsh command, replacing:

YOUR_DNS_NAME with your DNS name
THUMBPRINT with the thumbprint acquired in step 3.15*

*Remove any spaces and/or any strange characters in the copied thumbprint.
GUID with the GUID created in step 3.18

netsh http add sslcert certstorename=MY hostnameport=YOUR_DNS_NAME:443
certhash=THUMBPRINT appid='{GUID}'



Example:
netsh http add sslcert certstorename=MY hostnameport=s3archivel.xendata.com:443
certhash=f558c8b0f6ffb5bbf143f372524829b2dda8a159 appid="{6dd8738a-b7b1-46af-a184-
24cde77be7b2}

If successful, the command will return the following message:

SSL Certificate successfully added

3.19 Add the chosen DNS to your hosts file in windows, the file is located in:
C:\Windows\System32\drivers\etc\hosts and can be opened with Notepad
3.20 Open a web browser and point to the DNS. You should be able to access it



